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Abstract
The objective of this paper is to assess and map groundwater potential zone in  Lemo woreda and Hosana town  by the
integrating approach of Geospatial Techniques. For this purpose both primary and secondary data were used. Ground Control
Points (GCP) were collected from Google earth; Digital Elevation Model (DEM) and Landsat 8 down loaded, besides, secondary
data such as, soil data, rainfall, and Lithology were collected from different governmental institutions. Ground water controlling
factors, namely, lithology, Geomorphology, slope, land use land cover (LULC), rainfall, lineaments, soil, and drainage density were
generated. In order to map ground water potential area, Geographic Information System (GIS), Remote Sensing and Analytical
Hierarchy Process (AHP) were used. AHP was used for computing weight for the parameters by comparing eight factors. The
consistency ratio was less than 0.1(CR -0.03) which is acceptable weight to compute weighted overlay analysis in GIS
environment .The weight derived for Rainfall, slope, Geomorphology, Soil type, lineaments density, drainage density , land use
land cover (LULC) and lithology are:27%, 17%, 16%, 12 %, 9%, 8%, 6% and 5%, respectively, and the groundwater prospective of
the area is qualitatively classi�ed into �ve classes, namely, very high, High, moderate, low, and very low which account for
14.04%, 20.34%, 26.68%, 28.51%, and 10.44% the study area, respectively. The cross-validation of the resultant model was
carefully carried out using spring, and water well data. The result tells most of spring and water well overlaying high and very
high groundwater potential zones. As a result, the map generated using this platform could be used as a preliminary reference in
selecting potential area for groundwater exploitation.

Introduction
Groundwater is water that exists underground in saturated zones beneath the land surface. This is one of the most valuable
natural resources, which supports economic development, by assisting, human health, ecological diversity ,agricultural, and
industrial use in many regions of the world (Burke & Moench, 2000; Hosseinifard & Mirzaei Aminiyan, 2015).It can be considered
as the largest single freshwater source in many parts of the world, especially during prolonged dry periods (Assaf & Saadeh,
2008). According to (Chow, Maidment, and Mays, 1988) from the total freshwater to be present on the earth, almost 30 % exists
in the form of groundwater, and less than 1% is available at lakes and rivers.

At least two billion people around the world rely on ground water as their only source of drinking water (UNEP, 2003). Because
reliability of surface water is threatened by climatic condition, ground water is the best in abundance and its less susceptible
contamination than surface water, and important source of water supplies in all climatic regions including both urban and rural
areas of developed and developing countries (Naghibi, Moghaddam, Kalantar, Pradhan, & Kisi, 2017).

Ethiopia is has been shown progressive ful�lment of its urgent water needs as past and recent studies describe (Tamiru, 2006).
But it is has to be unable to satisfy all the necessities of all population yet.The role of groundwater for water supply and
irrigation is increasing with time in Ethiopia (Bitsiet and Dessie, 2019).

Lemo woreda and Hosanna town administrative found near to and at heart of the Hadiya Zone. In the last ten years the
population of this area has been increasing at exponential rate. This rapid growth of the settlement has brought about a
tremendous increase in the demand for water supply.so that to overcome this problem groundwater is another alternative.

The common problem in utilization of groundwater is, well production and it requires huge amount of investment cost to utilize
this valuable resources.in addition to this improper assessment of groundwater and site demarcation mostly expected to pose
the problems. Since the groundwater occurs out of our sight, deep in the subsurface, there is no direct method to facilitate
observation of water below the surface, but it can only be inferred indirectly by studying the groundwater occurrence and
distribution controlling parameters. The parameters that control availability and occurrence of ground water are geology, slope,
lineaments, drainage density, land- use/land-cover, Rainfall, surface runoff and geomorphology of the area (Shaban et al., 2005).

There are several methods that can be used to assess groundwater but can be grouped into two major categories these are
conventional and advanced methods. Conventional methods of exploration may not be highly reliable due to assessment of
diverse factors which affects the presence of groundwater (Biswajeet&Saro et al. 2012). In Ethiopia, most of groundwater
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potential zone assessment has been done conventionally, using in situ measurement which is not feasible and effective in cost
and time (Bayessa et al. 2002; Tesfaye, 2012).

Nowadays, GIS and RS is an e�cient tool to assess and storing large volumes of data, integrating spatial and non-spatial
information in a single system, offering a consistent framework for analysing the spatial variation, and allowing manipulation of
geographical information (Fares M. Howari, Mohsen M et al, .2017).It also help to Integrate all parameters which in�uence
groundwater potential zone analysis including spatial and temporal data from satellite image (Kamal, 2017) .Besides to this,
(Gupta and Srivastava, 2010) explain that several approaches such as Multicriteria Decision Analysis (MCDA), Analytical
Hierarchy process (AHP) support in decision-making on ground water potential zone assessment and mapping. AHP is useful for
weight assignment, pairwise comparison matrix and checking consistency ratio (Saraf and Choudhury, 1998).These decision
makers use to reduce the bias in decision making (Saaty, 1980). Therefore the present study was focus on the assessment of
groundwater potential zone in Lemo woreda andHossana town, of Hadiya Zone with integrated approach of geospatial
technologies.

The main objective of the study is to assess and map groundwater potential zone in Lemo woreda and Hosana town by the
integrating approach of Geospatial Techniques.

Study area

This study was conducted in Lemo woreda and Hossana town, the area located in Hadiya Zone, Southern Nation Nationalities
and People’s Regional State (SNNPRS), Ethiopia (Fig. 1). The study area is located in south of Addis Ababa the capital of
Ethiopia and near to the administrative centre of Hadiya zone. The study area is 232 km away from Addis Ababa.
Geographically, situated between 7°22′00″–7°45′00″N latitude and 37°40′00″– 38°00′00″E longitude. The study area has
39,879.00 hectares (398.7900 km2). (Hadiya Zone Finance and Economic Development O�ce, 2020) 398.790063. According to
Zonal report, the study area is characterized by topography of hills, valleys, plains and mountains. The altitude ranges from
1836 to 2700 meters above sea level. The study area weather conditions includes: Dega, Woine-dega and Kola .The mean
annual rainfall ranges from1000-1200mm and the mean annual temperature ranges from 13-23ºc.According to the National
Metrological Agency (NMA, 2021), the lowest temperature, (12.1°C) was records during summer (July) and the highest
temperature (23°C) is records during March.

Materials And Methods
To achieve the objectives of this study, both primary and secondary data are used. Some of the data used in this research
generated from different sources. The major data used in this study includes Soil (30×30 m resolution) and digital elevation
model (30×30 m resolution) were collected from the ministry of water, irrigation, and electricity of Ethiopia (MOWIE),Satellite
image (30 х 30 m resolution) downloaded from USGSEarth Explorer website (https://earthexplorer.usgs.gov), for January 2020
and the land cover map was prepared from landsat8 by classifying the satellite image and verifying with ground truth points.
The geology and lineament map (at a scale of 1: 250,000) were collected from the geological survey of Ethiopia (GSE). Slope,
drainage and elevation maps were derived from the digital elevation model (DEM); while drainage density and lineament density
maps were derived from drainage and lineament maps respectively and Rainfall data taken from Ethiopia National Meteorology
Agency. All the required thematic maps were developed from the collected datasets using ArcGIS 10.5 Software. The eight
thematic layer maps such as Lithology, Rainfall, Geomorphology, slope, soil type, Lineament density, drainage density and land
use land map generated were converted into the raster format using Arcmap 10.5 and used them for the overlay analysis.
Groundwater potential zones were obtained by the weighted overlay analysis method using spatial analysis tools in
ArcMap10.5. During weighted overlay analysis, a rank was given for each individual parameter of each thematic layer map, and
weights were assigned according to the output of the MCDM (AHP) technique to that particular feature on the hydrogeological
environment of the study area. The data used and their description are provided in Table1.

Material and Software to be used
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The following software and equipment were used for in the process of analysis and generating Flood vulnerability map, these
include: ERDAS IMAGINE 2014, Arc Map10.5, AHP and Google earth was used for collection of ground control points to validate
for land use / cover map.

 Analytic Hierarchy Process (AHP)

The groundwater delineation in the study area involved thematic map generation and their integration through GIS
environments. Prior to integration of different information, individual class weights and map scores was assessed based on
satty’s Analytic Hierarchy Process (AHP) (Saaty, 1977). Where a pair-wise comparison matrix prepared for each map using a nine
point important scale and weighted depending on relative importance. In general, nine objects are the most which an individual
can simultaneously compare and consistently rank. The score of differential scoring assumes that the row criterion is of equal
or greater importance than the column criterion. The reciprocal values (1/3, 1/5, 1/7, 1/9) have been used where the row criterion
is less important than the column criterion. To ensure the credibility of the relative signi�cance used, AHP also provides
measures to determine inconsistency of judgments mathematically. Based on the properties of reciprocal matrices, the
consistency ratio (CR) can be calculated. CR < 0.1 indicates that level of consistency in the pair wise comparison is acceptable.
Saaty (1980) suggests that if CR is smaller than 0.10, then the degree of consistency is fairly acceptable. But if it is larger than
0.10, then there are inconsistencies in the evaluation process, and AHP method may not yield meaningful results. The result
uni�ed weight map containing due weights of all input variables. The weight values this �nal map further logically was
classi�ed to arrive at delineation of groundwater potential zone map. This provides a broad idea about the groundwater prospect
off the study area. To achieve the �nal target of the study, delineation of groundwater potential zones, different thematic layers;
Lithology, geomorphology, lineament density, drainage density, slope, soil, landuse/land cover and rainfall integrated using GIS
and Remote Sensing techniques.

Lt = lithology; RF = Rainfall; Ge = geomorphology; SL = slope; DD = drainage density; Soil; LULC = land use land cover; LD =
lineament density

Weight Normalization

To normalize the values, divided the cell value of comparison matrix by column total (sum) and calculated the priority vector or
weight by determining the mean value of the rows (Saaty, 1980).Priority weight was calculated by averaging the values in each
row to get the corresponding ranking, which gives the results of normalized weights of each parameter as presented in
Table3.17.below.

Note: The weight values represent the priorities which are absolute numbers between 0 and 1. The eigenvector is an estimate of
the relative weights of the criteria been compared. Because individual judgment will never agree perfectly the degree of
consistency achieved in the ratings is measured by a Consistency Ratio (CR) it indicates the probability that the matrix ratings
were randomly generated. The rule of thumb is that a CR less than or equal to 0.1 .reciprocal matrix, a ratio over 0.1 indicates
that the matrix should be revised

CR =
CI
RI……………… (Eq. 1)

 CI =
( λmax−n)

( n−1)  ……………… (Eq. 2)

CI =
(7.69 − 8)

(8 − 1) = − 0.044

…
RI = Random consistency

n = number of criteria.

 λmax , = is Σ of the products between each element of the priority vector and column totals.
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 Based on the computed AHP value CR is lower than the threshold value of 0.1(CR= -0.03) and indicates a su�cient level of
consistency in the pair wise judgments, and implies that the determined weights are acceptable. Each factor was prepared for
the weighted overlay in Arc GIS with Weighed Linear Combination method (WLC).

Ranking Method and weighted overlay

To generate criterion values for each evaluation unit, each factor weighted according to estimated signi�cance for identi�cation
of ground water potential area. There are two ways of doing this; straight ranking (very high =5; high= 4; moderate =3; low   =2,
very low = 1).

The criteria maps depicting different potential area of ground water are overlay on Arc GIS 10.5 These thematic Layers are such,
as lithology ,Rainfall,Geomorpphology,Slope, drainage density, soil type, Lineament density, and land-use/land-cover, are
reclassi�ed and computing weigh based on their in�uence on availability of ground water.

Results And Discussion
Ground water potential area delineation

To assess ground water potential zones, important factor maps were considered, and the maps were prepared for each layer.
Each factor determining the ground water potential zones in the study area is classi�ed into �ve classes .Theses criteria maps
were altered to raster data sets having the same pixel size (Resolution) and different weightage were assigned using AHP
(Analytical Hierarchical process) as per their groundwater potential controlling capacity within the study area and
reclassi�cation of each map was done based on the weight values produced. The combination method follows the conventional
scheme for GIS‐based MCDA (Malckzewiski, 1999). It involves three main phases. First, the criterion maps were standardized/
reclassi�ed using Spatial Analyst’s Reclassify tool. This approach is important since the criterion maps include the ordinal
values (very high, high, moderate, low and very low) indicate the level of potential area of ground water. Secondly, derivation of
the weights of relative criterion importance using the pair wise comparison method (cf. assigning criterion weights‐section). The
criterion weights are automatically calculated once the pair wise comparison matrix is entered in the AHP weight derivation
module. Third, the criterion weights and the standardized criterion maps were combined/ aggregated by means of the weighted
overly analysis (WOA) operations. Finally the expected groundwater potential areas for the study area were delineated. 

 Presence of Ground water is strongly associated Lithology, Rainfall, Geomorphology, slope, soil type, Lineament density,
drainage density and land use land. To assess potential ground water potential area using GIS and remote sensing, weighted
overlay analysis were used. MCE is a procedure which needs several criteria to be evaluated to meet a speci�c objective. 

 Rainfall

Groundwater recharge is controlled by various factors with rainfall playing a key role since it represents the main source of
groundwater recharge ( Gebhardt, H.; Glaser, R.; Radtke, U.;2011 Reuber, P;Lakshmi, S.; Reddy, Y.2018; ). The annual mean rainfall
for the period from 2011 to 2020 in the study area was obtained from national meteorological agency (NMA) .The rainfall data
were converted to a raster layer using the conversation Tools . We then converted the raster layer to points using the tools
Conversion Tools > From Raster> Raster to point. These points were interpolated through the tools Spatial Analyst Tools
>Interpolation > Kriging to obtain a rainfall contour map. The rainfall map for the study area was extracted using the tools
Spatial Analyst Tools > Extraction > Extract by Mask. The rainfall map of the study area is shown in Fig.3. The northwest part of
the study area receives rainfall of around 1076.5–1,250.4 mm/year; the eastern part receives rainfall of around 749.2–1,167.1
mm/year. In the southern part, the recorded rainfall is around 1,167.1–1,364.5 mm/ year, and in the northeast part, the recorded
rainfall is around 1076.7–1,167.161 mm/year. The rainfall in�uence on groundwater occurrence likely depends on the southwest
and central rainfall, which has a high amount of rainfall from June to September, about 1,250.5–1,364.5 mm/ year. The rainfall
distribution along with the southwest part directly affects the in�ltration rate and hence increases the possibility of groundwater
potential zones in the study area.

Slope
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It is a topographic setting relates to the local and regional relief situation and gives an idea about the general direction of
groundwater �ow and its in�uence on groundwater recharge and discharge. The slope is one of the crucial variables which is
predictable to groundwater revive. It controls the ratio of penetration and surface spill-over. It gives awareness about the amount
of groundwater recover dependent on the slope angles. Steeper the slope, greater will be the runoff and thus lesser is the
groundwater recharge. Digital Elevation model (DEM) is derived using contour information from the topographical map for
estimation of slope in degree. The identi�ed slope category varies from 0° to 300 degree in the study area and area classi�ed in
to �ve classes like 0-3° (�at), 3 -6° (gentle), 6-10° (moderate), and 10.1-15° (steep) 15.1°-30° (very steep). �at slope (0–3°)
indicates the presence of very high groundwater potential zones where as steep slope (>15°) shows the presence of poor
groundwater potential zones as water runs rapidly off the surface and does not have su�cient time to in�ltrate the surface,
keeping other parameters constant. 

The Geomorphology of the area

Geomorphology re�ects many land form and structural landscapes and several topographies are inspiring the event of
subsurface water and categorized in terms of groundwater possibility. Geomorphology i.e. landforms of the study area  
developed from SRTM 30m digital elevation model using land form mapping as presented by Morgan et al (2005) procedure in
ArcGIS’s spatial analyst tool. Land from is a combination of slope, relief and pro�le. The classi�cation and description is
adopted from Dikau’s landform codes (Dikau, R etal., 1995). Technically a landform map is not complete without the, geologic
history and the process that resulted in for the landforms presented in the maps. In this case, however, the map is satisfactory
for the intended purpose.

The identi�cation and characterization of various landforms and structural features in the study area are very important from
geomorphological study point of view. Which are mandatory for groundwater potential zone mapping (Shifaji and Nitin,
2014).The geomorphology reclassi�ed in terms of groundwater recharge and potential the geomorphology of the study area
classi�ed in to �ve units main geomorphic units identi�ed in the area are �at plain, smooth plain, irregular plain, Escarpment, low
Hill, Hills ,low mountain ,

 Small Mountain and hills are the cover small area types of geomorphological class in the area; see Fig. 4.2.Groundwater
occurrence map, those suitable areas are found with geomorphic class of Flat plain and irregular plain because of high
in�ltration rate: Escarpment, low hills, hill, low mountain landform, ground water is low. Locational, small hills to the north and
south western part of the study area.. There is a maximum runoff associate with Landforms which characterized by hills slope.
This shows poor Potentiality for groundwater potential and recharge possibility. However, there is a small portion of land, which
has high elevation compared to local surrounding land.The rank assigned to the individual landform classi�cation according to
its respective in�uence of groundwater occurrence, holding and recharge, as presented in �gure 5: Geomorphology and its rank
as per suitable for groundwater potential and recharge.

Soil

 The characteristics, types and distribution of soil for a certain area depend on geomorphology, geology, relief, time, and other
factors. Soil properties in�uence the relationship between runoff and in�ltration rates which in turn controls the degree of
permeability, the principal factor in hydrogeology that determines the groundwater potential (Kumaret etal., 2016; Magesh et al.,
2012;Tesfaye 2010). Soil type is a medium that controls the groundwater exposure which is an important in determining the
intrinsic vulnerability. In line with FAO and according to the Ethiopian Ministry of Water Resource Soil Classi�cation, the
prevailing soil types in the study area were classi�ed into six major groups, namely, loam( pellic vertisols, orthic solonchaks)soil
which accounts for 57.12% area coverage, Clay(vitric Andosols, Eutric vertisols) which accounts for 57.12% area coverage ,
sandy Clay loam(Chromic luvisols) which accounts for 57.12% area coverage , clay Loam(Calcic xerosols, Eutric nitisols) which
accounts for 57.12% area coverage as shown in Fig..6 The result showed that pellic vertisols and orthic solonchaks soils are
found the most dominant in terms of area coverage with area coverage of 34.34%, 8.09%,and 0.45%, respectively and more
determinant in groundwater occurrence and movement as compared to Calcic xerosols and vitric Andosols These soil types are
characterized by poor to good in�ltration property. Figure 6 shows the soil map of the study area.
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Lineament Density

A lineament is usually de�ned as structural lines such as faults, which often represent zones of fracturing and increased
secondary porosity and permeability, and therefore of enhanced groundwater occurrence and movement. In hard rock terrain the
storage and movement of groundwater is controlled by the secondary porosity i.e. presence of lineaments and fractures.
Lineaments for lineament density computation are extracted from SRTM (DEM) which downloaded from path 169, row 55.
Lineaments of the study area from remotely sensed data provides important information on subsurface fractures that may
control the movement and storage of the groundwater. The distribution of the lineaments is observed to be high on the
escarpment and rift �oor (Figure 7). These are normal faults having a NW-SE orientation. Faults may act either as pathways for
water movement or as �ow barriers. At the foot of some of the fault scarps which bound the basin there exist springs indicating
that these faults act as drains. The faults in the escarpment areas which comprises the older undifferentiated rocks of Nazret
Group and Dino Formation down faulted towards the rift �oor resulted in the development of in the study area. High density of
the faults is observed near northwest and southeast. Those, faults on the �oor may possibly be �lled with a weathered glassy
volcanic ash. In such cases the faults could act as barriers (Nedaw, 1997). Most of the lineaments are identi�ed Classi�ed into
lineament density map in to �ve categories, i.e. 0.902 -1.51(very high), 0.588 -0.901(high), 0.375 – 0.587(medium), 0.131-
0.374(Low) and 0- 0.13 (very low) in the study area (Figure 7) 

Drainage Density

Drainage density is one of the important indicators of groundwater recharge (Magesh et al., 2012) and groundwater occurrence
(Sener et al., 2005). In fact, it is linked with water percolation properties of underlying lithology, consequently having close
relation with groundwater mapping. The drainage density is an inverse function of permeability. An area with low permeable
surface prone to high drainage density and water comes from precipitation goes to a high runoff as well and vice versa. As a
result, high drainage density implies low groundwater potential. The Drainage density was delineated using SRTM(DEM
with30m)resolution data of the study area after consecutive processes such as Importing of SRTM data, �lled sinks for
unde�ned values, created Flow Direction, Created Flow Accumulation, created Stream network, generated Stream Order and
�nally converted Stream Order to drainage density using a spatial analysis tool in ArcGIS 10.8. Afterwards, a drainage density
map is produced using a kernel density analysis tool (Figure 8). As per the de�nition of preceding studies (Greenbaum, 1985;
Magesh et al., 2012), drainage density (DD) is the total length of the stream segments divided by the unit area .The stream order
values were regrouped to produce a drainage density map that was reclassi�ed into �ve categories based availability of
 potential of Ground water i.e., namely “very good” (0–0.00005148 km/km2), “good” (0.00005149–0.0001214 km/km2),
“moderate” (0.0001215–0.0001809 km/km2), “poor” (0.000181–0.0002482 km/km2), and very poor (0.0002483 –0.0003366
km/ km2). In the study area, 1.73% and 25.07% of landscape were found in 0–0.00005148km/km2 and 0.00005149–0.0001214
km/km2drainage density class, respectively. This implies the availability of good groundwater potential zones. Moreover, 61.18%
was entitled under drainage class with good potentiality for groundwater storage. (�gure.8). 

Land Use/Land Cover

 LULC is an important factor affecting groundwater recharge, groundwater occurrence, and availability (Hussein et al., 2016;
Kumar et al., 2016; Pande, Khadri, Moharir, & Patode, 2017; Yeh, Cheng, Lin, & Lee, 2016). Supervised image classi�cation was
conducted to classify and identify the type of LULC, where Landsat 8 (OLI) satellite image of 2020 with 30 m spatial resolution
used. to increase visibility Image pre-processing are conducted in order to analyse remotely sensed images, the different images
representing different bands must be stacked, that is, band 1 to 7 LULC 2020 satellite images and classi�ed in ERDAS imagine
2014. Image classi�cation the LULC change studies usually need the development and the de�nition of homogeneous LULC
units before the analysis started. It is differentiated using the available data source such as remote sensing, Google earth,
ground control points and the previous local knowledge. Following this, the tool, ERDAS imagine 2014 software was used for
classi�cation of the LULC image of the area. In remote sensing, there are various image classi�cation methods, that is,
supervised and unsupervised. For this study, we used the most common type of classi�cation technique, supervised
classi�cation type. First, Google earth was taken as a signature for the classi�cation. Second, we performed the classi�cation
using the maximum likelihood classi�er. Lastly, the accuracy assessment was performed using Google earth image for the LULC
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2021, 100 random points were generated in Arc GIS10.5. Following these procedures, random points were converted to KML to
layer (Hengl et al., 2015). Whereas, the accuracy assessment of 2020 LULC map was used ground truth points as a reference
and 100 points were taken to validate the classi�cation; which was built in 12/05/2020. The analysis result was performed
using confusion/ error matrix. The land use/cover map of the area was readily interpreted from Landsat image of the year 2020
by using visual interpretation, supervised classi�cation using ERDAS 2014 software. On the result of Classi�cation of land
use/cover for analysis is used for identi�cation of the ground potential area. The study area consists of �ve types of LULC
(Figure 5) namely; agricultural area 203.88 (51.13%), forest cover area 112.27 (28.15%), grazing land area 21.64 (5.43%), shrub
land area 33.28 (8.35%), urban area 27.72 (6.95%) total area of Land use/ Land cover map of the area398.79 km2

Lithology

The way of Geologic formation and genetic type is essential condition for ground water �ow, transport and mineral composition.
Types of rocks determine peculiarities of hydrological crosssection structure, type of porosity values, the nature of permeability,
geological structure geomorphology and character of spatial heterogeneity of �ow and transport parameters. Lithology has a
principal impact on the occurrence and movement of groundwater as it highly controls the in�ltration and �ow processes
(Tolche, A, 2020) stated that the rock type can substantially in�uence the groundwater recharge potential. Similarly, (El-Baz, F.;
Himida, I.; 1995) found that lithology affects the recharge by governing the water percolation. Some investigations have
neglected the lithology parameter in ground water potential  zoning by considering the drainage features and lineament density
as a measure of primary and secondary porosity; however, we followed (Yeh, H etal,;2016)by including the lithology in our
analysis to minimize the uncertainty in estimating drainage and lineament densities. The Geological map was then added to
ArcGIS, and the study area was extracted using the tools Analysis Tools (Extract tool). Lithological categories classi�cation was
done according to the classes available in the lithology classi�cation for Ground water potential zone assessment.

Mapping Ground water potential Areas 

In this stage, the AHP results were integrated into a GIS system to map Ground water potential areas using Weighted Linear
Combination (WLC). The WLC / simple additive weighting rely on the concept of a weighted average where continuous criterions
are standardized to a collective numeric range, and then combined by means of a weighted average (Drobne and Lisec, 2009).
The WLC technique can be carried out using any type of GIS system possessing the overlay. The output of this WLC method
gave a map the most potential �ood susceptible areas. To compute the groundwater potential areas, a weight linear
combination was applied as shown in Equation (3).

GWPZM = (27 * RRf) +( 16 *RGm) +(17*RSl)+( 12 *RSt) +( 9 *R Ld )+ (8 * R Dd )+( 6 * RLulc) + (5 * R Lith)…………………………
(Equation 7) 

Where, RRf: Reclassi�ed Rainfall Map, RGm: Reclassi�ed Geomorphology Map, RSl: Reclassi�ed Slope map, Rst: Reclassi�ed
Soil Texture Map, RLd: Reclassi�ed Lineament density Map, RDd: Reclassi�ed Drainage density Map, RLulc: Reclassi�ed Land-
use/land-cover Map and RLith: Reclassi�ed Lithology Map. 

Rainfall, geomorphology, slope, soil type and lineament density holds the highest value relative to the other parameters. The
weight assigned for Rainfall were greater than the weight of other, which in�uence the occurrence of groundwater potential and
recharge zone than others parameters (Mwega, 2013; Kamal et al., 2016). The result for groundwater potential zones was
classi�ed in to very high, high, moderate, low and very low Figure 11

The potential area is divided in to �ve classes. Those were, very high, high, moderately, low and very low groundwater potential
areas (Figure 11). In the study area by very high and high ground water area potential areas covers 14.04% and 20.34%. The very
high and the high ground water   potential areas are found  in the South west and  Central part of the study area and very low
ground water  potential areas area a found at upper parts of the study area speci�cally in the Northern and North eastern  part.
 Moderately ground water potential areas are found in the major near to urban area    and included settlements as classi�ed in
the land use map. 
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As can be seen in Table 4.9, means more than 14.04% and 20.34% of the area was found in very high and high ground water
potential areas and the remaining as moderately to very low ground water area potential areas. The Very High ground water
potential areas a total coverage of 5385.51Ha (53.8551 km2) of the total area. “High” ground water potential areas have total
area of the district covers 7803.36 Ha(78.0336km2) ,the “Moderately” ground water  potential areas, covers 10240.11
Ha(102,4011km2) of the total area , “low” ground water   potential areas covers 10939.59Ha(109.3959 km2) and very low ground
water  potential areas covers 4005.19 Ha(40.0519km2) (see table 14).

Conclusions And Recommendations
Conclusions

This study tried to assess in groundwater potential zone by using GIS and remote sensing techniques through Analytical
Hierarchy process (AHP) to identify and delineate groundwater potential area.  For this purpose eight parameters were selected
which have more affects the occurrence of groundwater potential, prior to overlay analysis. The AHP design showed that rainfall
has the highest weight in recharging Ground water through the spatial-weighted overlay. From all parameters (Lithology, Rain
fall, geomorphology, Slope, drainage density, soil, Lineament density and LULC).also the geomorphology parameter was the
most important parameter because it in�uences the in�ltration water in to the soil, and �ow direction. This approach allows
decision makers to give the judgments in order to reduce complexity in decision making processes. The results of consistency
ratio in this study were -0.03. If the result of consistency ratios are greater than 0.1, the value is unaccepted and it must be re-
evaluated. In this case, the consistency ratio for groundwater potential a zone was less than 0.1 and the value was accepted for
further analysis. The delineated Groundwater potential zone were classi�ed into �ve zones namely, ‘very low’, ‘low’, ‘moderate’,
‘high’ and ‘very high’. Very low zone shows that the low suitable area for groundwater prospect. Whereas very high zone indicates
the most suitable area for groundwater prospect. Very high potential areas present in �at plains, and lacustrine sediments, which
coincide with the low slope and high lineament density of the study area. Very low groundwater potential falls in the area
highland with, high slope and high drainage density. The acceptable results were done by comparing the borehole yield data with
the Groundwater potential zone map of the study area. The effective parameters in the area for groundwater potential is
Lithology, rainfall, slope, geomorphology, lineament density, and drainage density in Pairwise Comparison matrix analysis
indicates that all parameters are signi�cant. Around 14.04% zone under very high groundwater potential and the next high
potential; area covers 20.34%, Moderate groundwater potential zone where 26.68 % covers, the  low and very low  coverage  of  
groundwater potentials area shares 28,51% and10.44 % respectively. 

Recommendation

High potential groundwater potential area was based on the �ndings obtained and conclusions reached the following
recommendations were forward as follow: 

The same appropriate methods were recommended for complex areas to delineate groundwater potential zone in the small
area.

 The groundwater potential map along with other thematic maps forms serve as resource information database that can be
updated from time to time by adding new information.

 For further validation, �eld geophysical investigations on the potential well drilling sites are recommended.

Identi�ed to the north and north east of the study area are low suitable  for groundwater potential zone but   south western
parts of the study area part of the study area is have better ground water potential . In this research, integrated GIS and
remote sensing techniques are very useful, time and cost effective tool for the identi�cation and delineation of groundwater
potential zone analysis.

Generally even if the investigation of groundwater potential in certain areas is vital, but further investigation has to be performed
to be assured of its reliabilities. Furthermore, the studies can be done on the quality and its suitability for different aspects such
as drinking, agricultural and industrial activities should be considered for further Investigation 
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Table 1: Types of data used and their sources
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Data Type Data type
 

Scale/Resolution

/Format

          Source Relevance

               
 Primary Data

Landsat 8
(OLI)  

OLI (30m*30m)

(2020 year: path

169 and Row 55

United
StatesGeological

Survey (2020)

To prepare land use/land-cover, 

 DEM        
          

SRTM
(30m*30m)

United States
Geological

Survey (2020)

Used to generate Slope, Drainage, Geomorphology
and lineament maps of the study area.

Rainfall
data 

Excel Format NMA(1998-
2020)

To generate rain fall map  of the study are

Borehole
Data

Excel Format Collectedby
HandledGPS

Used to validate the

groundwater potential map

Secondary

Data

Geological
map

1:250,000 EGS (2012) Used to generate Geological

 Map of the study area

Digital
Soil type 

Shape File Ministryof
Agriculture

Used to generate the soil map

of the study area

Table 2: The types of Software and their application area

No Software and Material  to be used
                    

Major application Area

1 Arc Map 10.3.1                               thematic map generating, Reclassi�cation, Area Calculation, map lay out and    
 weighted  overlay, accuracy

2 ERDAS IMAGINE 2014                   Image processing and Land use/ cover classi�cation

3 Microsoft Excel                                 Rainfall data Analysis, Interpolation and to calculate Return period and
Probability of occurrence of �ood.

4 Google earth Ground truth for land use/cover classi�cation

5 AHP To compute weight for factors

Table 3: Satty’s Analytic Hierarchy Process a nine point important scale

Rating 1/9 1/7 1/5 1/3 1 3 5 7 9

Qualitative 

Description

Extremely Strongly

 

Strongly

 

Moderately Equally Moderately Strongly strongly Extremely

                Less importance               More importance

Weight Assessment and Normalization

Ranking of criteria of Ground water potential area parameters 

Table 4: Comparison Matrix
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Criteria RF Geom Slope Soil LD DD LULU Litho Priority Weight%

RF 1 2 3 3 3 2 4    4 27

Geom 1/2 1 1 1 2 3 3   7/2 16

Slope 1/3 1 1 2 2 3 3   7/2 17

Soil 1/3 1 1/2 1 4/5 4/5 2   2 12

LD 1/3 1/2 1/2   5/4 1 1/2 2   2 9

DD 1/2 1/3 1/3 5/4 2 1 10/9  5/4 8

LULC 1/4 1/3 1/3 1/2 1/2 9/10 1   2 6

Litho    1/4        2/7        2/7        1/2   1/2 4/5 1/2   1 5

sum 3.4 6.4   6.9 10.5 11.8 12 16.6 21.2 100%

Table 5: Weight Normalization of comparison matri

Criteria RF Geom Slope Soil LD DD LULC Litho Criteria weight

RF 0.28 0.31 0.43 0.28 0.25 0.16 0.24 0.18 0.26623

Geomo 0.14 0.15 0.14 0.09 0.16 0.25 0.18 0.16 0.15875

Slope 0.09 0.15 0.14 0.19 0.16 0.25 0.18 0.16 0.1650

Soil 0.09 0.15 0.07 0.09 0.06 0.06 0.12 0.09 0.09125

LD 0.09 0.07 0.07 0.11 0.08 0.04 0.12 0.09 0.08375

DD 0.14 0.05 0.04 0.11 0.16 0.08 0.06 0.05 0.08625

LULC 0.07 0.05 0.04 0.05 0.04 0.07 0.06 0.09 0.05875

Litho   0.07    0.04  0.04     0.05 0.04 0.06 0.03 0.04 0.04625

sum 1 1 1 1 1 1 1 1 1

Table 6: Random Consistency Index (RI) (Saaty, 1980).

n  1  2  3  4  5  6  7  8  9  10 

RI  0  0  0.58  0.90  1.12  1.24  1.32  1.41  1.45  1.49 

Table 7: Reclassi�ed Rainfall map of the study area

Factor      (mm classi�cation Ground water potential Rank

Rainfall  747.2-950.6  Very low rainfall Very low 1

950,7-1074 Low density low 2

1075-1164 Medium rainfall moderate 3

  1165-1248 high rainfall high 4

  1249-1365 Very high Very high 5

Table 8: Reclassi�ed Slope value of and its rank as per suitable for ground water potential 
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Factor Slope degree classi�cation Ground water potential Rank

Slope 0-3° Flat very High 5

3 -6° gentle High 4

6 -10° moderate Moderate 3

  10.1 -15° steep Low 2

  15.1 -30° Very steep  Very low 1

Table 9: Reclassi�ed Geomorphology map and its rank as per suitable for ground water potential 

Factor      Types Rank Ground water potential

Geomorphology Small mountain 1 Very Low

 hills 2  Low

Low Hills 3  Moderate

Regular plain 4 high

  Flat plain 5 Very high

Table 10: Type soil and its hydrological properties

Factor      Classi�cation  Ground water potential Rank

Soil Type clay Very poor 1

Clay loam Poor 2

Sandy clay loam Moderate 3

  Sandy loam High 4

       

Table 11: Reclassi�ed Lineament Density map as per suitability of Ground water potential 

Factor       Km2 Rank Ground water potential

Lineament

density

0 − 0.13 1 Very low

0.131 − 0.374 2 Low

0.375 − 0.587 3 Moderate

  0.588 − 0.901 4 High

  0.902-1.51 5 Very high

Table 12: Reclassi�ed Drainage Density map as per suitability of Ground water potential

Factor       Km2  classi�cation Ground water potential Rank

Drainage density 0-0.00005148 Very low density  very good 5

0.00005149- 0.0001214 Low density good 4

0.0001215-0.0001809 Medium density Moderate 3

  0.000191-0.0002482 high-density Poor 2

  0.0002483-0.0003366 Very high density Very poor 1
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Table 13: Reclassi�ed lulc map as per suitability of Ground water potential

Factor     lulc type Ground water potential Rank

LULC  Urban area Very low 1

Forest land low 2

Shrub land moderate 3

  Grazing land high 4

  Agricultural land Very high 5

Table 14: Reclassi�ed lithological map  as per suitability of Ground water potential

Factor       Km2 Rank Ground water potential

Lithology

 

Nazret group 4  high

Pumice& trachytic 3 moderate

Rhyolitic &trachytic 2 low

  ignimbrites 1 Very low

Table 14: Relative area of Ground water potential zone in the study area 

Ground water potential  level   Area in km2  Relative       % Area

Very high 53.8551 14.04

High  78.0336 20.34

Moderately  102.4011 26.68

low  109.3959 28.51

Very low 40.0519 10.44

Total 383.7375 100 %

Figures
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Figure 1

The location of the study area.

Figure 2
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Methodological Flow chart of groundwater potential area assessment using Geospatial technique mapping methodology in
Lemo Woreda and Hossana town

Figure 3

Reclassi�ed Rainfall map 

Figure 4

Reclassi�ed Slope map of the study area
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Figure 5

Reclassi�ed Geomorphology map 

Figure 6

Soil map of the study area
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Figure 7

Lineament density map of the study are

Figure 8

Reclassi�ed Drainage density map of the study area.
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Figure 9

Land use land cover map of the study area

Figure 10

Reclassi�ed geological map of the study area



Page 22/22

Figure 11

Groundwater Potential Zone Map of the Study Area


